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Capstone Experience Project and Presentation Projected Expenses 
 

The actual expenses incurred in the preparation and duplication of the capstone 
experience final project and presentation will vary. The following is a list of expenses 
that may be incurred: 
 

1. A $10 graduation fee made payable to Bemidji State University must be attached 
to the Application for Graduation (Form 4) and submitted to the School of 
Graduate Studies during the first week of the semester the candidate plans to 
complete the final capstone experience course. 

 
2. Printing of the FINAL Graduate Project and Presentation report. Students must 

submit one copy of their project prior to the completion of the capstone course 
(an electronic copy is preferred – send to jmiller@bemidjistate.edu).   

 
3. An appropriate binder for the submission of the FINAL Graduate Project and 

Presentation report is provided by the School of Graduate Studies. 
 
 

Steps to the Successful Completion of the Master of Education 
 

1. Once approval has been given for Admission to Candidacy (Form 2), the 
candidate completes required coursework as approved. 

 
2. In the FINAL capstone experience course, the student, with assistance from the 

course instructor, selects the non-departmental member and field representative 
for the final project and presentation. 

 
The following forms must be completed and submitted to the School of Graduate Studies 
during the capstone experience course.  
 

3. Form 3, Graduate Project and Presentation Approval Form. The candidate 
prepares a proposal in the capstone experience course in consultation with the 
capstone experience course instructor, non-departmental member, and field 
representative. Once all committee members approve the project, Form 3 is 
signed and submitted to the School of Graduate Studies. A resume for the Field 
Representative must be attached.  

 
4. Form 4, Application for Graduation should be submitted to the School of 

Graduate Studies within the first week of the semester for which the student is 
registered for the capstone course. 

 
5. Form 5, Graduate Project and Presentation Final Approval must be signed by 

the course instructor, non-departmental member, and Field Representative upon 
completion of the final project. Form 5 must be included with the FINAL copy 
of the project that is submitted to the School of Graduate Studies.
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Page Sequence of the Graduate Project and Presentation 
 
Every capstone experience project submitted to the School of Graduate Studies must 
conform to the following requirements.  
 See page 

1. Label on front cover........................................................................................6 
2. Form 5, Graduate Project and Presentation Approval Form...........................7 
3. Front page – unnumbered ...............................................................................8 
4. Title page - small Roman i..............................................................................9 
5. Acknowledgment page (optional) - small Roman iv ....................................10 
6. Table of Contents page(s) - small Roman numeral(s) ..................................11 
7. References or Bibliography – Arabic number(s) ..........................................12 

 
Note: All page numbers, both Roman and Arabic, are to be placed in the upper 
right corner of the page. The placement is 1/2" from the top of the page and aligned 
with the right margin. Page numbers are required. A page header (the first two or 
three words of the title) is optional.  
 

Definitions 
 
Binding – One copy of the capstone project and presentation report must be submitted to 
the School of Graduate Studies in a black heavy-duty report cover with metal fasteners 
(two- or three-hole punch). The exact title of the project and presentation and full name 
of the author must appear on the front cover. The School of Graduate Studies provides 
the binder. 
 
Front Matter – This section consists of all preliminary information prior to the text of 
the project and presentation report. 
 
Margins - The left margin must be one and one-half inches (1½”) in width with the other 
margins (top, right, bottom) one inch in width. All typing must be within the margins. All 
page numbers are to be ½ " from top of page aligned with the right margin. The text of 
the paper must be double spaced. 
 
Page Numbering Sequence – All front matter pages (the front section) must be 
numbered in Roman Numerals. The title page is counted as the first page, and is 
numbered “i”. All text pages must carry Arabic numbers beginning with “1”. Every page 
must be accounted for in the numbering system with the exception of the fly leaf sheets 
and the author approval page.  
 
Paper –The entire paper must be of the same quality, the same brand, and the same 
degree of whiteness. For the capstone experience report, 20-pound, non-cotton 
printer paper is acceptable. 
 
References or Bibliography – All studies must contain source information reported 
using the style and formatting guidelines of the 5th Ed., American Psychology 
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Association (APA). The References or Bibliography pages should follow the text, and the 
pages are numbered in sequence with the text.  
 
Table of Contents – The Table of Contents is a complete listing with page numbers of 
all sections of the project and presentation report. The Table of Contents is to be a 
detailed listing of all major subdivisions of the text rather than just a list of chapter 
headings. Entries – It is essential that wording in the Table of Contents listing be 
identical to that of the headings in the text in every case.  Page Numbers – Align the 
page numbers flush right with dot leaders. In Microsoft® Word, go to the Format menu 
and select Tabs. Type in the tab stop position and select Alignment Right and Leader 2. 
 
Word Processing – The final copy must be produced on a letter quality printer. 
 

Text – The text is the main body of the project and should be double-spaced. 
The text is divided into sections called Headings (i.e. chapters, subdivisions). There 
must be an exact correspondence between the headings in the text and the 
entries in the Table of Contents. 
 
To center text vertically on a page:  

1. Show formatting symbols: On the Standard toolbar, click on the ¶ icon. 
2. At the bottom of the previous page, insert a section break: In the Insert 

menu, select Break; under Section break types, select Next page. 
3. On that next page, type the text to be centered vertically.  
4. At the bottom of the page, insert a section break.  
5. Center the page vertically: (a) Go back to the page to be centered vertically. 

(b) In the File menu, select Page Setup; go to the Layout tab; under Page, 
Vertical alignment, select Center. (c) Be sure that the Apply to: box shows 
this section, and click on OK. 

 
Title Page – The title page contains the exact title of the project and presentation, the 
full name of the author, the degree to be awarded, the institution granting the degree, 
and the year the degree will be granted.  
 
Type Styles and Symbols – One size of type (12 pt. font preferably) must be used 
throughout the paper.  



 

 
 
 

 
 
 

Sample Front Matter Pages 
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(no page number needed) 

Label Sample 
 
This is a sample of the label that goes on the front of the binder(s) for the project 
and presentation document. If you do not have the computer capability of creating 
a label, contact the School of Graduate Studies. 

 
Label Sample 

 
Do not include this  

in your project and presentation 

document. 

 
 
 
 
 
 

 
 

THE TITLE IS IN ALL CAPS, CENTERED, AND 
SINGLE SPACED  

(1 blank line) 
by 

(1 blank line) 
John H. Doe 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Label size is approximately 2”x 4”. Text must be centered vertically and 
horizontally. The label must be affixed to the front cover of the project and 
presentation report. 
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(no page number needed) 

 7 

 Form 5 – Graduate Project and Presentation Final Approval 
 
 
 

Retrieve Form 5 from the School of Graduate Studies website or in your capstone 
experience course. No page number required for this page.



 (no page number needed) 

Front Cover 
 

Establish a left margin of 1.5 inches on ALL pages for binding purposes and be certain 
to maintain a margin of at least 1 inch on the top, right, and bottom of the page.   

From the 1-inch top margin, text begins on line 33, typed in upper and lower case, 
single-spaced, and centered. Do not place a page number on this page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

School of Graduate Studies 
Bemidji State University 

1500 Birchmont Dr NE, # 30 
Bemidji, MN  56601-2699 

218-755-2027 
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Sample Title Page 
 
Margins: 1.5 “ left; 1” top, right, and bottom. Center the text vertically on this page 
(see Word Processing, Text, p. 13). Use Roman numeral page numbers on Front 
Matter pages; place the numbers ½ inch from top edge, flush with right margin. 
 

TITLE OF CAPSTONE EXPERIENCE PROJECT AND PRESENTATION  
SHOULD BE IN ALL CAPS 

(1 blank line) 
by 

(1 blank line) 
William Robert Howard 

 
 

(7 blank lines) 
 
 
 

____________________ 
(line is 20 spaces long) 

 
 

(7 blank lines) 
 
 
 

A Capstone Project and Presentation Submitted to the Faculty of the 
DEPARTMENT OF PROFESSIONAL EDUCATION 

(1 blank line) 
In Partial Fulfillment of the Requirements 

For the Degree of 
(2 blank lines) 

 
MASTER OF EDUCATION 

(2 blank lines) 
 

BEMIDJI STATE UNIVERSITY 
Bemidji, Minnesota, USA 

(1 blank line) 
June 2005 

(1 blank line) 
Copyright 2005 by William Robert Howard 

(optional copyright notice) 
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 (Roman Numeral) 

Sample Acknowledgments Page (Optional) 
 
This page is optional. Margins: 1.5” left, 1” top, right, and bottom. Roman numeral 
page number must be ½ inch from top edge and flush with right margin. Text 
should be centered and begin 3” from top of paper or 11 blank lines from the 
1-inch top margin.   
 
 
 
 
 

ACKNOWLEDGMENTS 
 
 

The author wishes to thank Jane Doe 
for her special assistance in the 
preparation of this manuscript. 
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 (Roman Numeral) 

Table of Contents 
 
Headings must be presented in a format identical to the form used in text.  
 
Roman numeral page number must be ½ inch from top edge and flush with right 
margin. Margins are 1.5” left, 1” top, right, and bottom. Center all text vertically 
within the margins.  
 

TABLE OF CONTENTS 
 
Chapter Page 

1. Introduction........................................................................................................1 
(1 blank line) 

2. Title ....................................................................................................................2 
 (1 blank line) 

3. Title ....................................................................................................................3 
 
 References....................................................................................................................10 
 
 
Page Numbers – Align the page numbers flush right with dot leaders. In Microsoft® 
Word, go to the Format menu and select Tabs. Select or type in the tab stop position 
and select Alignment Right and Leader 2 ……. . Please note that the page numbers 
are not italicized. 
 
Roman numeral page number must be ½ inch from top edge and flush with right 
margin. Margins are 1.5” left, 1” top, right, and bottom. Begin the text at the 1-inch 
top margin. 
 

 
(Arabic Page Number) 

 
Chapter Headings 

 
 
One level.  Only use Level 1. Start each chapter on a new page. 
 
Example: 
 

Centered Uppercase and Lowercase Heading 
(1 blank line) 

The indented, double-spaced text starts here. All headings (Level 1) are centered 

and uppercase and lowercase. 
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 (Arabic Page Number) 

References or Bibliography Samples 
 

Arabic page number must be ½ inch from top edge and flush with right margin.  
Margins are 1.5” left, 1” top, right, and bottom. 
 
 References – only the sources that are cited in your project 
 Bibliography – sources for background or for further reading; you may include 

descriptive notes with the source listings 
 
If a resource listing breaks between two pages, start the resource on a new page. 
 
 
One format: hanging indent, single spaced, 1 blank line between each resource.  
 

References (APA) 
(1 blank line) 

Kyle, R. M. J. (1965). School-to-work transition and its role in systemic reform of 
education. Washington, D.C.: National Institute for Work and Learning, Academy 
for Educational Development. 

(1 blank line) 
Luecking, R., & Fabian, E. (2000). Paid internships and employment success for youth in 

transition. Career Development for Exceptional Individuals, 23(2), 205-210. 
(1 blank line) 

National Organization on Disability. (2002). What is the employability gap? Retrieved 
December 2, 2004, from http://www.nod.org/content.cfm?id=968 

 
 
Another format: hanging indent, double spaced throughout. 
 
Kyle, R. M. J. (1965). School-to-work transition and its role in systemic reform of 

education. Washington, D.C.: National Institute for Work and Learning, Academy 

for Educational Development. 

Luecking, R., & Fabian, E. (2000). Paid internships and employment success for youth in  

transition. Career Development for Exceptional Individuals, 23(2), 205-210. 

National Organization on Disability. (2002). What is the employability gap? Retrieved  
 
 December 2, 2004, from http://www.nod.org/content.cfm?id=968 
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